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USING THE AR/IR FILE ON CD-ROM 

1. WELCOME 

Welcome to the Cannon Air Force Base (AFB) Administrative Record (AR) File on CD­
ROM (Compact Disk Read Only Memory). This set of three CD-ROMs contains images of 
all installation restoration program documents in the AR file (through 1997) and the 
applications needed to search and view the images. With this information, you can perform 
detailed searches of the AR textbase to identify specific documents, and then view the 
selected documents page-by-page or print selected document pages. For further information 
on the AR file, contact the Cannon Environmental Restoration office at (505) 784-6378or by 
fax at (505) 784-1093. These instructions have been developed to walk you through the 
step-by-step approach of retrieving and viewing the selected documents. 

2. THE ADMINISTRATIVE RECORD 

An initiative to establish AR files at each of the installations was performed by the U.S. Air 
Force Headquarters Air Combat Command (HQ ACC) during 1992-1994. The initiative was 
coordinated through the Headquarters Environmental Protection Agency (HQ EPA), EPA 
regional offices, state regulatory offices, Secretary of the Air Force offices, Air Staff, HQ 
ACC, and base organizations. This initiative standardized the AR files at each ACC 
installation, and also created and standardized an information repository (IR) file (a copy 
provided for public review) for each base. During that time, the HQ ACC Legal office 
developed ACC guidance detailing specific types of documentation that would be considered 
and incorporated into the AR file. This guidance parallels the EPA's Office of Solid Waste 
and Emergency Response (OSWER) Directive 9833.3A-1, "Final Guidance on ARs for 
Selecting CERCLA Response Actions". 

The ACC guidance provides for an AR file that is the collection of all documents used to 
support the decision for selecting response actions at an ACC installation. Both the AR and 
IR files are updated as new documentation is made available, until all of the final response 
decisions have been made for remediating sites on an installation. 

To manage the documents, HQ ACC developed an AR textbase consisting of 30 datafields 
using INMAGIC® DBffextWorks™ software. This software allows the user to execute 
detailed searches on the AR datafields to select documents of interest. The runtime version 
of this software, DB/Search Works™, is included with the CD-ROM set (on CD Volume 1). 
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Because of the large quantity of documents comprising the AR/IR files, storage at libraries is 
becoming an issue for many U.S. Air Force installations. To remedy the storage problem, 
HQ ACC implemented an initiative to scan ACC installations' AR files onto CD-ROM. HQ 
EPA approved use of this technology as an alternative to maintaining a hard copy of theIR. 
Cannon AFB is one of the ACC installations using this technology. 

3. BEFORE YOU START 

To view and print documents from the ARJIR file on CD-ROM, the computer you are using 
must have the CD Image Retrieval software installed on the hard drive. If you do not find a 
program group and icons for the CD Image Retrieval software on the Windows 3.1 desktop 
or in the Start/Program menu in Windows 95/98/NT, you will first need to install this viewer 
from Volume 2 of the CD-ROM set. 

4. INSTRUCTIONS FOR LOADING THE KODAK CD IMAGE RETRIEVAL 
SOFTWARE 

2 

a. Place CD Volume 2 in the CD-ROM drive of the computer you are using. 

b. In Windows 3.1, choose Run from the Program Manager File menu. For 
Windows 95/98/NT, click on the Start button and select Run. 

c. When the Run window appears, type in d:\app_spec\cdimgwetup.exe, where dis 
the drive letter for the CD-ROM drive on your computer, and select OK. 
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d. The CD Image Retrieval screen will be displayed. Review the information in the 
window and then choose Continue. 

CD Image Retrieval f3 

Welcome to the CD Image Retrieval Setup 
program. 

This program will setup your PC to run the CD 
Image Retrieval application. You may choose to 
either run the application from the CD or from a 
local copy of the application which this program will 
create for you on your hard disk. 

This program will also create a program group for 
CD Image Retrieval. 

e. The Set Windows Path screen is displayed. The Path edit field specifies the full 
path of your Windows directory. Choose Continue to use the Windows directory 
shown. 

Set Windows Path f3 

The setup program will copy some files into 
the Windows directory. Enter the path of 
your Windows directory below. 

Path: !til\'tJ!~I~II 
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f. The Set Destination window is displayed. It displays the directory where the 
application will be installed. Under Installation Options, select the Install 
Application and System Files on Local Disk button. 

Set Destination E3 
You may choose to install the application locally or to install only the 
necessary system files and run the application from the CO. Running 
on a local disk will improve the application's performance. 

In either case, the application's error log will be kept in the location 
entered below. 

··· Install to: ·· ·· ·--· ·· - ·---- ···· ········ --· 

C:\COIMAGE 

Installation Options:-

r. Install APplication and System Files on Local Disk 

r Install ~stem Files 0 nly 

Installation Drive: C: 
Space Required: 1376 K 
Space Available: 351808 K 

g. H you want to change the directory where the application will be installed, select 
Set Location (the default path typically is the most appropriate). The Set 
Destination Path window will appear. Enter the appropriate path and choose 
Continue. 

Set Destination Path ~ 

The setup program will copy CD Image 
Retrieval files into the following directory. 

Path: IC:\COIMAGEI 
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h. The Set Destination window will be redisplayed. Select Install from the Set 
Destination window. 

Set Destination E3 
You may choose to install the application locally or to install only the 
necessary system files and run the application hom the CD. Running 
on a local disk will improve the application's performance. 

In either case, the application's error log will be kept in the location 
entered below. 

Install to:·· 

C: \CD IMAGE I []ii!tT!;P.J;.~.ffii~i]J 
·····Installation Options: ....................................................................................................................................................................................... , 

r. lnstaii8Jlplication and System Files on local Disk 

r Install ~stem Files 0 nly 

Installation Drive: C: 
Space Required: 1376 K 
Space Available: 351808 K 

i. The Set CD-ROM Drive screen is displayed. Enter the drive letter designating the 
CD-ROM drive on your computer (for example, D), then choose Continue. 

S~CD~OMDri~ ~ 

• " . . 

Enter the drive letter designating 
the CD-ROM drive on your system . 

CD-ROM Drive: ~ 
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j. The next series of screens shows the setup program copying the appropriate 
application files from the CD-ROM to your hard drive. When the installation is 
complete, the CD Image Retrieval program group and icons are created and the 
Setup Complete message window is displayed. Choose OK to exit the setup 
program. 

Setup Complete 13 

Setup Successful! 

5. SEARCHING THE ARIIR FILE TEXTBASE 

Searching is the process of finding information in the textbase. A search is a request to find 
all of the records that match specific requirements. By using the INMAGIC® 
DB/SearchWorks™ software, you will be able to search your textbase on any field or 
combination of fields, sort the results by the field of your choice, and output a report using 
one of five pre-designed formats that have been provided. You will run the 
DB/SearchWorks™ software directly from Volume 1 of the CD-ROM set, and must not 
remove this CD from the CD-ROM drive of your computer until you close the software (see 
section 5.2 for instructions on closing DB/Search Works™). 

5.1 Starting the DB/SearchWorks™ Software 
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a. Place CD Volume 1 in the CD-ROM drive of your computer. 

b. In Windows 3.1, choose Run from the Program Manager File menu. For 
Windows 95/98/NT, click on the Start button and select Run. 
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c. At the Run window, type in d:\adminrec\cannon\dbsgsrch.exe, where d is the 
drive letter for the CD-ROM drive on your computer, and select OK. 

Run 013 
.. · ... :.·:):1·;? 

....•... ~Jf~~,·~~~fi~Jti~~······: 
. WiD operiitfi;ltyou.· · ·· 

d. The DB/SearchWorks™ 2.1 Run-time window will be displayed. Choose Open 
from the File menu. (If this is the first time DB/Search Works™ has been used on 
this computer, you will get the User File Path window with a default path of 
c:\windows in the selection box. Select OK.) 
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e. The Open Inmagic DB!fextWorks Textbase window appears. Select cannon.tba 
from the resulting dialog box then select OK to open the Cannon AFB ARIIR 
textbase. 

Open lnmagic DB/T eHt\1/orks T eHtbase DEi 

f. The Query by Example (QBE) window will now be on your screen. Each box on 
the QBE screen represents a field you can search. 

FILE NUM 
~~~PI u..__ ____________ _...... 

.. IRP FL 

J~n1~----------------------~ 
Fl LOC 

iN~:I~------------~ 
TYPE 

·~~~~-------------~ 
.......... QUAL 
i~P:I~~--------------------~= 

.. DATE 

j~g4~----------------------~'-= 
REC DATE 

~ '--------------------
SU Tl 

~~~1~----------------------~-
AU 

'~P'l~------------~ 
AU AFF 
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5.2 Closing the DB/SearchWorksTM Software 

You can close your DB/SearchWorks™ session at any time by choosing Exit from the File 
menu. Be sure to leave CD volume 1 in the CD-ROM drive of your computer while closing, 
then remove the CD when the software is closed. You must exit the software before using 
the CD Image Retrieval software to view ARIIR file documents. 

5.3 Developing a Search Strategy 

The first- and most important- step in any search is to develop a search strategy. To 
do this, you must identify the objective of your search: What are you looking for, and how 
do you want the results presented? If you are preparing a report based on the search results, 
how much data from the index do you want to display? 

There are 30 fields in the textbase providing a variety of information about each ARIIR file 
document. The field labels, field names, and a brief description of each field are provided 
below, in the order they appear in the QBE window. 

• FILE_NUM (ARIIR File Number): The unique identifier for each document. 
• IRP _FL (IRP File Number): The Air Force Record Information Management 

System (RIMS) generated file code from the installation's file plan. 
• FL_LOC (File Location): The location of the document. 

• TYPE (Document Type): Description of the document type, such as plan, 
correspondence, memorandum, etc. 

• QUAL (Document Qualifier): Description of document quality or status. 

• DATE (Document Date): The date of the document. 

• REC_DATE (Receipt Date): The date the document was received at the 
environmental office. 

• SUffl (Subject/Title): The title or subject of the document. 

• AU (Author): Name of the individual(s) author. 

• AU_AFF (Author Affiliation): The organization or agency with whom the author 
is affiliated. 

• CORP _AU (Corporate Author): The name of a company or agency author. 

• RECIP (Recipient): Name of the document recipient. 

• RECIP _AFF (Recipient Affiliation): The organization or agency with whom the 
recipient is affiliated. 

• ATTCHMT (Attachment): Description of the attachments to a document. 

• COPY _TO (Copy To): Name of person or agency receiving a copy of the 
document. 

Using the AR/IR File on CD-ROM- Rev 06/99 9 



• KEYWORD (Keyword/Environmental Resource): The environmental resource 
affected, or other keywords. 

• NOTES (Notes): Additional information about the document. 

• SITE_NUM (Site Number/Name): The IRP site number and name. 

• HAZ_CONTAM (Hazard/Contaminant): The hazard or contaminant discussed 
in the document. 

• EPA_FILE_NUM (EPA File Number): File code referencing EPA's file 
structure. 

• OU (Operable Unit Name or Number): The name or number of the IRP operable 
unit. 

• PROJ_NUMBER (Project Number): The USAF-assigned project number for 
contracts. 

• ROD _DATE (Record of Decision Date): The date of a final record of decision. 

• DA TE_ENT (Date Record Entered): The date the record was entered into the 
AR textbase. 

• DA TE_MOD (Date Record Modified): The date the record was modified in the 
AR textbase. 

• EPA_REGN (EPA Region Number): The EPA region where the installation is 
located. 

• INST_CODE (Installation Code): The unique three letter identifier for the 
installation. 

• INST_NAME (Installation Name): The installation name and state where 
located. 

• MAJCOM (Major Command): The major command to which the installation 
belongs. 

• PR_DA (Privacy Data): This field references any Privacy Act information in the 
document. 

Use the most logical textbase field for your search. For example, if you are searching for 
TCE, a contaminant, use the HAZARD_CONTAMINANT field for your search, rather than 
the SUBJECT_ TITLE field. If you are searching for site information, use the SITE_NUM 
field. 

5.4 Using Boolean Operators 

Before we go any further in our discussion of searching, let's talk about search "theory." 
You will use tools called Boolean operators - AND, OR, NOT - to expand and limit 
searches. 
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Suppose you are looking for a document that pertains to Site Ff-06 and was written by the 
EPA. The AND operator limits the search to those documents that are both about Site Ff-06 
and from EPA. Documents that are about Site Ff -06 but not from EPA, and documents 
from EPA that do not pertain to Site Ff -06, are excluded from the findings. Only 
documents that meet both criteria will be included. This is probably the most common type 
of search you will use. 

Perhaps you need to find all documents that pertain to Site Ff -06, from all sources, as well 
as all other documents from EPA. The use of the OR operator expands the search. Findings 
will include all documents that meet either criterion. As you can see, this will result in a 
much larger set of search findings. 

Perhaps you need to search for all documents pertaining to Site Ff -06 except those from 
EPA. The use of NOT limits the search in a different way than the use of AND. The 
findings would include only those Site Ff -06 documents that meet both criteria - about Site 
Ff -06 but not from EPA. In other words, the Ff -06 documents from EPA would be 
excluded from the search findings. 

5.5 Understanding the Browse Feature 

The Browse function is one of the most useful features of DB/Search Works™, allowing you 
to examine the actual contents of each indexed field during the search process; thus, 
eliminating the guesswork in searching. You can paste items from the lists into the QBE 
boxes to search for documents to which these criteria pertain. Pasting is recommended 
because it is more accurate, and often quicker, than typing. By pasting a word or term, you 
guarantee that it matches information in the textbase. Otherwise, if your datafield entry is 
not in the correct format, it may not be recognized by the query. 
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While in the QBE form, you can browse through the entries in a given field either as terms 
or words. To browse, place the cursor in the box for the field you wish to browse, and click 
on the Browse icon or press F3. Terms appear in the Browser dialog box. For example, the 
following screen illustrates the query choices available for pasting in the Type datafield. 

Query Choices Browser: TYPE £! 

Data 
Fact Sheet 
Index 
Meeting Agenda Minutes 
Memorandum 
Plan 
Press Release 
Record of Decision ROD 
Report 

The number at the beginning of each line indicates the number of records that contain the 
word or term shown. You can paste terms or words into the QBE form by double-clicking 
the selection or clicking Paste. 

5.6 Finding Records 

After determining your search strategy, you are ready to begin searching the textbase. When 
you open the textbase, you see the QBE window. Each box on the screen represents a field 
that you can search. There are two basic techniques that you can use to find records: 

• Typing the information required in one or more field boxes, or 

• Using the Browse feature (the Eyeball button from the toolbar row) to select 
words or terms. 

To find records that satisfy multiple conditions, type or paste information in two or more 
boxes, then toggle the Boolean operator button in front of a box (AND, OR, NOT) to 
determine how the result of the search in that box is combined with boxes already evaluated. 
To toggle a Boolean operator button, click the button with the mouse or tab to a button and 
use the spacebar. 
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For example, let's fmd all documents related to Ff -06, written after 1997, which are not 
correspondence. Start the search at the QBE screen. 

AU AFF 

ANDI~----------------------------­
CORP AU 

ANDj '----------------......., 
RECIP 

ANQI '----------------
RECIP AFF 

ANol '---------------........ 
ATTCHMT 

~ol~---------------­
copv TO 

ANDI'------------------------~ 
KEYWORD 

:mol'--------------------~ 
NOTES 

The first criteria (Ff-06) can be pasted in the SITE_NUM field box by using the browse 
function. Place the curser in the SITE_NUM field box and select the Eyeball icon on the 
toolbar or press F3 to browse. 

SITE NUM 
~PI u...__ ___________ ___... 

HAZ CONTAM 

~~~'---------------------
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The Query Choices Browser for SITE_NUM will appear. Select FT -06 from the list and 
choose Paste, then Close. 

Query Choices Browser: SITE_NUM 13 

AOC-36 Rubble Pile 
AOC-D Nonfriable Asbestos Burial Pit 
AOC-E Bore Site Mound 
AOC-F Disposal Pit 
AOC-6 Potential Old Landfill 
AOC-H Potential Old Landfill 
DP-16 Solvent Disposal Site 
DP-33 o· Pit 

The second criteria (documents after 1997) can be typed in the DATE field box. In this case, 
documents after 1997 are identified by using the search item > 1997. Place the curser in the 
DATE field box and type >1997. 

FilE NUM 

~~£!.1 '---------------...=.11 
IRP Fl 

~PI'---------------__...... 
Fl lOC 

~m~------------~ 
TYPE 

1§1~--------------~ 
QUAl 

{-~~'--------------~ 
DATE 

1111~1>~1~~7----~r---------------------~~ 
REC DATE ht 

r••~-----------~ SU Tl 

'!IIQ!I '---------------...=.11 
AU 

••~-----------~ AU AFF 
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The third criteria (documents that are not correspondence) can be pasted in the TYPE field 
box using the Browse function. Place the curser in the TYPE field box and select the 
Eyeball icon on the toolbar or press F3 to browse. The Query Choices Browser for TYPE 
will appear. Select Correspondence from the list and choose Paste, then Close. 

Query Choices Browser: TYPE 1;3 

at a 
Fact Sheet 
Index 
Meeting Agenda Minutes 
Memorandum 
Plan 
Press A elease 
Record of Decision ROD 
Report 

Next, click on the Boolean operator box for the TYPE field until the operator becomes 
NOT to exclude documents that are correspondence from the search (according to our search 
criteria). 

~FILE NUM 

IRP H 

·~m~~----------------------
Fl LOC 

.gij '--------------_____..... 
TYPE 

(NQ\ ~~~=espondenc• 
~~~~-----------------------

DATE 

~~~~~>~19~~----------------------------~W 
REC DATE 

~P:I '--------------____...... 
SU Tl 

~1'-------------------------=· 
AU 

~@;1~--------------------------· 
AU AFF 
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To execute the query, just click the Go button on the QBE toolbar or choose Execute Query 
from the Search menu. 

IRP Fl 

~gl~--------------------------~ 
Fl LOC 

'•01~------------------------~ 
TYPE 

'NP!II ~Correspondence 
QUAL 

i~9J~------------------------~ 
DATE 

;•~1~1>~19~97 ______________________________ ~ 

After executing the query, a DB/Search Works™ message window appears reporting how 
many records met your search criteria. If there is a match, you can view them in the report 
window by selecting Yes. 
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At any point in the query process, you can clear all the fields and enter new search criteria by 
clicking the New Query button on the QBE toolbar or choosing New Query from the 
Search menu. 

Fl lOC 

~nl~------------------------~ 
TYPE 

NO'fjl =Correspondence! 

QUAl 

~~~~------------------------~-
DATE 
1>1997 

6. VIEWING AND PRINTING REPORTS 

6.1 Formatted Reports 

After retrieving a set of records from your query, you can view and print a report of your 
results in a variety of defined formats. The five available report formats were developed to 
meet the needs of U.S. Air Force personnel and members of the public interested in viewing 
AR file documents. These report formats are: 

• the lmageNum format, 

• the EPA/ndex format, 

• the Longlist format, 

• the Shortlst format, and 

• the Sitelst format. 
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All the reports provide basic identifying information about each AR file document, including 
the AR file number, subject/title, author, and document date. For the purpose of selecting 
AR file documents to view, the lmageNum report will be most useful as it also identifies 
which volume of the CD-ROM set holds the AR file documents you want to view. A sample 
ImageN urn report printed for our previous query example is shown below. 

CD ARIIR File 
Volume Number 

01 

229 

4 361 

4 365 

4 367 

393 

Cannon AFB, NM 
CD Volume and ARIIR File Number Report 

Dale of Report: 6/28/99 

Author or 
Title or Subject Corporate Author 

Admmastratlve Record File Index LABAT-ANDERSON 
INCORPORATED 

Management Action Plan Radian Corp. 

RAB Mcctmg Mmutes, 15 May 97 27CES/CEVR 

RAB Mcctmg Mmutes, 14 Aug 97 27 CES/CEVR 

Final Report for Naturally Occuning Concentrations Woodward-Clyde Consultants 
of lnorganzc and Background Concentrations of 
PestiCides 

RAB Meetmg Mmutcs. 08 Jan 98 27 CES/CEVR 

6.2 Selecting Report Forms 

Document Date 

08 Jun 98 

Dec 97 

29 Jul97 

14 Aug 97 

Sep97 

08 Jan 98 

• Choose Select Forms from the Display menu. The following window appears. 

• To select a form for a particular operation, click one of the three buttons: Record 
Display, Report Window, or Report Printing. 
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• A dialog box displays the forms available for that operation. The basic report 
form provided by DB/SearchWorks™ is listed first, and then the forms designed 
specifically for AR file documents are listed alphabetically. The form currently in 
use is highlighted in the dialog box. 

• Select a form or click Revert to Default to assign the textbase default form for 
the operation identified in the title bar of the dialog box (the default form for the 
Report Window and Report Printing has been set to lmageNum). Then click 
OK. 

6.3 Printing a Report 

When you have selected your preferred forms and executed a query, you are ready to print a 
report. 

~ Note the default report, ImageNum, includes the CD-ROM volume and ARIIR file 
number for each record in your query. You will need this information to view ARIIR 
file documents. 

There are two ways start a print report. 
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3 

A 

4 

5 

5 

20 

• Click the Print icon on the toolbar, or 

229 Management Actwn Plan 

365 RAB Meeting Minutes, 14 Aug 97 

367 Final Report for Naturally Occurring Concentrations 
of Inorganic and Background Concentrations of 
Pesbctdes 

393 RAB Meeting Minutes. 08 Jan 98 

• Choose Print from the File menu. 

393 

ort for Naturally Occurring Concentrations 
and Background Concentrations of 

RAB Meeting Minutes, 08 Jan 98 

INCORPORATED 

Radian Corp 

27 CES/CEVR 

Woodward-Clyde Consultants 

27CES/CEVR 

Radian Corp. 

27CES/CEVR 

Woodward-Clyde Consultants 

27 CES/CEVR 

Using the AR/IR File on CD-ROM- Rev 06/99 



• 
7. VIEWING DOCUMENTS WITH THE KODAK CD IMAGE RETRIEVAL 

SOFTWARE 

The following instructions will guide you through retrieving, viewing, and printing ARIIR 
file documents. Detailed instructions for using all the features of the CD Image Retrieval 
software are available in the application's on-line help menu. 

You must exit the DB/SearchWorks™ software before using the CD Image Retrieval 
software to view ARIIR file documents. If DB/SearchWorks™ is not closed, choose Exit 
from its File menu. Be sure to leave CD volume 1 in the CD-ROM drive of your computer 
while closing, then remove the CD when the software is closed. 

a. Place the CD volume containing the document you wish to view into the CD­
ROM drive. (Reference the ImageNum report you created in DB/Search Works™ 
for the CD volume and ARIIR file number information you will need to vtew 
documents.) 

Cannon AFB, NM 
CD Volume and ARIIR File Number Report 

Date of Report: 6/28/99 

CD ARIIR File Author or 
Volume 

4 

4 

4 

Number Tide or Subject Corporate Author Documeot Date 

01 Admimstrative Record File Index LABAT-ANDERSON 08 Jun 98 
INCORPORATED 

229 Management Action Plan Radian Corp. Dec 97 

361 RAB Meeting Minutes, 15 May 97 27CES/CEVR 29 Jul97 

365 RAB Meeting Minutes. 14 Aug 97 27CES/CEVR 14 Aug 97 

367 Final Report for Naturally Oecurring Concentrations W oodward-Ciyde Consultants Sep97 
of Inorganic and Background Concentrations of 
Pesticides 

393 RAB Meeting Minutes, 08 Jan 98 27CES/CEVR 08 Jan 98 

I@" Note ARIIR file number 1 is an index of the entire textbase for Cannon 
AFB, therefore the information in this document can be accessed by 
selecting all documents during your DB/SearchWorks™ query. You will 
not be able to view ARIIR file number 1 with the CD Image Retrieval 
software, and will not use CD Volume 1 for document viewing. 
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b. From the CD Image Retrieval Program Group on your Windows 3.1 desktop 
or the Start/Programs/CO Image Retrieval menu on Windows 95/98/NT, select 
CD Image Retrieval - Local. The CD Image Retrieval software starts, the CD 
Image Retrieval window appears, and the Select Database dialog box is 
displayed. The Cannon AFB database (CANNON) will be highlighted by default. 

Select Database £1 

c. With the CANNON database highlighted, choose OK. An empty CANNON 
window is displayed at the top of the CD Image Retrieval window. 
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d. Choose Find from the File menu, or click on the Binoculars I taJ icon in the 

application toolbar. The Find dialog box is displayed with a blinking cursor 
placed in the field box titled AR_NUMBER. This is the only field you will use to 
view images. 

ljftft . Q xl 

e. At the blinking cursor, enter the ARIIR file number for the document you want 
to view. Then select OK. (This example will use ARIIR file 361.) 

f. The document you selected is automatically opened in an image window. The 
document page count is shown in the image window title bar. Maximize the 
windows on your desktop for the best image quality. 

HI 

CANNONAFB. 
NE\\' MEXICO"" 

ADMINISTRATI\'E :RECORIJ 
CO\'"Ell SllEET 

All Fl(e }iiDtlbcr 3 b ~ -
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g. Adjust the view as needed by Magnifying or Rotating the image using the 

options under the Image menu or by selecting the appropriate Magnify ·~·. -

or Rotate I cl icons on the tool bar. Selecting Reset from the Image menu will 
fit a full image to you viewing window. 

h. Navigate through the document by using the options under the Page menu or by 

selecting the Previous Page/Next Page icons on the toolbar. 

i. To view a new document, make sure the correct CD volume is in the CD-ROM 
drive for the next document you wish to view and repeat the retrieval process 
from step d (choose Find from the File menu, or click on the Binoculars icon in 
the application toolbar). 

~ Note the ARIIR file number from your last search is displayed in the Find 
dialog box. You can clear this entry by choosing Clear. 

j. To print one or more pages of the document, choose Print from the File menu. 
Select the pages for printing, then choose OK. 
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" k. When you are done viewing documents, exit the Image retrieval software by 
selecting Exit from the File menu. 
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